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Introduction

Use theMicrosoft Dynamics 365 Business Central Connector to send and retrieve data between BPA Platform and

your Dynamics 365 Business Central installation. This allows for data to be synchronised between Dynamics 365

Business Central and third-party systems that it does not normally connect with.

All communication uses XML; BPA Platform recordsets cannot be used as data inputs unless converted to XML first

(using the Convert Recordset to XML tool, for example). You use the Connector to map BPA Platform data to

Dynamics 365 Business Central objects and operations. Standard operations of READ, ADD, UPDATE, and DELETE are

supported as well as custom operations for specific objects. All objects available from the Dynamics 365 Business

Central API are supported, including codeunits, pages, and queries — see Supported Objects.

XML responses received back from the Dynamics 365 Business Central API can be saved and used by other BPA

Platform tools for further processing.

The Microsoft Dynamics 365 Business Central Connector Tool Pack

The tool pack consists of:

 Microsoft Dynamics 365 Business Central Agent— The Agent communicates directly with the Dynamics

365 Business Central API. It can be installed on any computer that has access to both the BPA Platform server

and the Dynamics 365 Business Central company database, local to the BPA Platform server, or the on-

premise server instance hosting the Dynamics 365 Business Central company database.

 Microsoft Dynamics 365 Business Central Connector— The Connector communicates with theMicrosoft

Dynamics 365 Business Central Agent instead of interacting directly with the Dynamics 365 Business Central

company database. It must be installed on the BPA Platform server and any remote BPA Platform client

machines which runMicrosoft Dynamics 365 Business Central Connector tasks.

System Requirements

The following prerequisite software must be in place before installing the Microsoft Dynamics 365 Business Central

Connector.

MinimumBPA Platform Version

TheMicrosoft Dynamics 365 Business Central Connector requires BPA Platform 2020 Update 1 or above.

MinimumDynamics 365 Business Central Version

TheMicrosoft Dynamics 365 Business Central Connector supports Dynamics 365 Business Central 2018 or higher.
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Architecture

The following diagrams provide example architectural layouts of the Connector with Dynamics 365 Business Central

deployed on-premise or in the cloud. Whether Dynamics 365 Business Central has been deployed in the cloud or on-

premises, you can choose to locate theMicrosoft Dynamics 365 Business Central Agent on any machine accessible

by the BPA Platform server or on the server itself

Cloud Architecture

Example architecture:
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On-Premise Architecture

Example architecture:

Working with Other Tools

TheMicrosoft Dynamics 365 Business Central Connector tool can directly interact with the following tools:

Consuming from Other Tools

TheMicrosoft Dynamics 365 Business Central Connector can consume output from the following tools:

Icon Tool Name Tool Category

Import XML Document Input

Retrieve Text Message Input
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Icon Tool Name Tool Category

Convert Recordset to XML Format

TransformData Format

Call Task Execute

Applications Platform Connector Data Connectors

Microsoft Dynamics 365 Business Central

Connector

Data Connectors

Objects Consumed

The Microsoft Dynamics 365 Business Central Connector consumes the following objects exposed by other steps:

 XML— XML data from any BPA Platform tool capable of exposing such data (see above)

Exposing to Other Tools

The following tools can directly consume output form theMicrosoft Dynamics 365 Business Central Connector:

Icon Tool Name Tool Category

Retrieve Text Message Input

Convert XML to Recordset Format

Run Microsoft Reporting Services Format

TransformData Format

Save File Output

Call Task Execute
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Icon Tool Name Tool Category

Applications Platform Connector Data Connectors

Web Service Connector Data Connectors

Microsoft Dynamics 365 Business Central

Connector

Data Connectors

Objects Exposed

TheMicrosoft Dynamics 365 Business Central Connector tool outputs the following objects which can be consumed

by other tools:

 InputData

This document contains the input XML received by theMicrosoft Dynamics 365 Business Central Connector

tool. It is only available if a task step has been selected as the Data Source (see About the General Tab).

 OutputData

The OutputData object contains two sub-objects:

 XmlString— This is the XML document produced by the tool, containing data returned from Dynamics

365 Business Central for all operations. Also included are the key fields for the mapped elements

affected by the used operation— for example, if using an ADD operation, the key fields for the top-level

object instances that are created are returned— and a SupplementaryReference field for task

auditing purposes.

The mapped fields in theMapping tab (see About the Mapping Tab) define the structure of this XML

document.

 XmlSchema— This contains the output schema in XSD format.
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 ErrorData

The ErrorData object also contains two sub-objects:

 XmlString— This contains any error data reported by Dynamics 365 Business Central

<Error>— All errors are created as an <Error> node, with the following sub-nodes:

   <Object />— The name of the requested object

   <CODE />— The error code returned by Dynamics 365 Business Central

   <MESSAGE />— The corresponding error message

   <EXTENDEDINFO />— A string containing additional information about the error

   <INPUTDATA />— The header input data (excluding child nodes) mapped for the object, plus all

data contained in SupplementaryReference

</Error>

 XmlSchema— This contains the output schema in XSD format.

 Step Properties

Standard step properties are also available allowing you to use statistical data of theMicrosoft Dynamics 365

Business Central Connector step.

Where Can the XML Output be Used?

The incoming XML is translated into the XML format for the object and operation selected in the configuration. The

data for the linked fields is brought across into the output XML— only those fields that are linked are brought across.

The XML is passed to the Connector, which then:

 Processes the data

 Performs the operation requested

 Recieves an XML document containing the response

Both the OutputData and ErrorData documents can be directly used by succeeding task steps that can consume

XML data, as part of an application integration or synchronisation process. To use the documents in a non-XML

consuming tool, use a Convert XML to Recordset step first to create a recordset copy of the XML data.

The XML documents are also available as consumable objects from the BPA Platform Browser (XmlString). When

used in a task step, such as Format as Text or Save File, this exposes the actual XML string.

6 of 38



Error Handling

Errors are written to the BPA Platform Event Log (Tasks toolbar > Event Log ). You define how errors are

handled in the Options tab of the tool (see About the Options Tab).

Reasons for the errors could include:

 Web service connection errors

 User privilege errors

 Errors from the API

 Warnings andmessages from the API
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Global Configuration

The global configuration for theMicrosoft Dynamics 365 Business Central Connector is used to create connections

to the Dynamics 365 Business Central Agent.

You open this interface from the resources tree — expand System > Tools > Data Connectors and double-click

Microsoft Dynamics 365 Business Central Connector in the items list.

When a connection is created, the available objects and fields of your Dynamics 365 Business Central installation are

retrieved.

Click Add to create a connection to Dynamics 365 Business Central.

NOTE: Youmay be restricted as to the number of Dynamics 365 Business Central company database

connections you can create. For more information, refer to the BPA Platform product help or consult your

Codeless Platforms account manager or partner.

Using Extended Logging

Enabling this option exposes the XML parsed between the Connector and Dynamics 365 Business Central.
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TIP: The Event Log database table may grow substantially large as extended logging adds additional rows for

each call made to and from the Connector. To manage this, adjust the maintenance routine for the Event Log —

refer to the BPA Platform product help.

Without extended logging, the Event Log only contains start and end of transactionmessages, plus any error

messages encountered at runtime.

You can view the extended log in the BPA Platform Event Log (Tasks toolbar > Event Log ).

About the General Node

Youmust name each connection you create to a Dynamics 365 Business Central database.

Provide a unique Connection Name. If your Dynamics 365 Business Central installation makes use of a number of

separate databases, it is recommended you add such details to the name. This is useful later when creating task

steps.

Updating Objects and Operations

Enabling Update Objects and Operations allows the Dynamics 365 Business Central schema in BPA Platform to be

refreshed every time an update is made in the API itself.

Should you also upgrade Dynamics 365 Business Central to a newer, compatible version, all related schemas within

BPA Platformmust be refreshed. To do this, select this option and save the changes. Youmust repeat this for each

existing connection you have defined.
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NOTE: After enabling Update Objects and Operations, youmust refresh the schema in eachMicrosoft

Dynamics 365 Business Central Connector task step. You do this in theMapping tab (Schema Refresh) — see

About the Mapping Tab.

About the Agent Connection Node

The Agent Connection node provides a brief summary of any configured Dynamics 365 Business Central Agents.

About theGeneral Node

Use the General node to determine which Dynamics 365 Business Central Agent this global connection is for.

In Connection Agent Server, enter the IP address or hostname of the machine where the Dynamics 365 Business

Central Agent is installed. If the Agent is on the same machine as this instance of BPA Platform, enable Use

Localhost.

By default, the connection is over HTTP and port 4212. If the Agent has been set up to use HTTPS or a different port,

enable Show Advanced Options.

Use Test Connection to ensure theMicrosoft Dynamics 365 Business Central Connector can communicate to the

Agent successfully.
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About the Advanced Node

Use the Advanced node to change the communication defaults for the Dynamics 365 Business Central Agent this

global connection is for. This node is hidden until Show Advanced Options in the Agent Connection > General node

is selected.

By default, the connection is over HTTP and port 4212.

To change the port used to communicate over, enable Set Custom Port Number and enter the required number in

the box provided.

To use HTTPS communication, enable Use HTTPS.

TIP: After changing any parameter on this page, use Test Connection in the General node to ensure successful

communication is maintained.
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About the Business Central Connection Node

The Business Central Connection node provides a brief summary of the configured connection to Dynamics 365

Business Central.

About theDeployment TypeNode

Use the Deployment Type node to determine whether this connection is for Dynamics 365 Business Central in the

Cloud or On-Premise.
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About the Cloud Connection Node

The Cloud Connection node provides a brief summary of the configured connection Dynamics 365 Business Central

in the cloud.

About the General Node

The General tab is only available when Cloud is selected as the Deployment Type.

For standard cloud deployments, click Authorise and enter the database user credentials required to access the

company database for this connection.

When deploying Dynamics 365 Business Central to the cloud, you can choose to create separate environments, for

example, for production and "live" purposes (for more information, refer to your Microsoft documentation). To

connect to such an environment, select Specify Environment and enter the environment name in the box below—

Connection URL shows the URL the Agent uses to connect to this environment and API. Then click Authorise and

enter the database user credentials required to access the company database for this connection.

Use Test Connection to ensure the Dynamics 365 Business Central Agent can connect to the database

successfully.

Use Log Out to disconnect the Agent from the API.
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About theOn-Premise Connection Node

The On-Premise Connection node provides a brief summary of the configured connection Dynamics 365 Business

Central when on-premise.

About the General Node

The General tab is only available whenOn-Premise is selected in the Deployment Type node.

Use the parameters in this node to create a connection to the Dynamics 365 Business Central server instance

hosting the company database you want to run tasks against.

Specifying the Server Instance

Provide the Hostname or IP address of the machine hosting the Dynamics 365 Business Central client.

In Server Instance, enter the configured name for this instance.

By default, the connection is over HTTP and port 7048. If the server instance has been set up to use HTTPS or a

different port, enable Show Advanced Options. A new node appears under On-Premise Connection— Advanced

— see About the Advanced Node.

The URL to the Dynamics 365 Business Central on-premise API is automatically built from the configuration you enter

above — see underneath Server Instance.
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Specifying Database Credentials

Youmust provide the Username and Password allocated to the Dynamics 365 Business Central Agent. They must

allow full access to the company database. Domain credentials can be used if required.

Use Test Connection to ensure the Dynamics 365 Business Central Agent can connect to the database

successfully.

About the Advanced Node

Use the Advanced node to change the communication defaults to the on-premise API. This node is hidden until

enable Show Advanced Options in the On-Premise Connection > General node is selected.

By default, the connection is over HTTP and port 7048.

To change the port used to communicate over, enable Set Custom Port Number and enter the required number in

the box provided.

To use HTTPS communication, enable Use HTTPS.

TIP: After changing any parameter on this page, use Test Connection in the General node to ensure successful

communication is maintained.
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About the Select Company Node

Use the Select Company node to choose the Dynamics 365 Business Central database this Agent is specifically

monitoring.

If your Dynamics 365 Business Central Agent is installed on a machine hosting more than one company database,

youmust create a separate global connection for each database you want tasks to access.

Step Configuration

When creating new tasks, theMicrosoft Dynamics 365 Business Central Connector tool is located under Data

Connectors of the Task Browser.

NOTE: It is not possible to add the connector tool to the task until at least one connection to a Dynamics 365

Business Central instance has been defined in the global configuration.

To add a newMicrosoft Dynamics 365 Business Central Connector step to an existing task, do the following:

From the relevant task, either:

 Click and drag theMicrosoft Dynamics 365 Business Central Connector icon from the Task Browser to the

task Design area.
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 From the task's Design tab, right-click on empty space and select New > Data Connectors > Microsoft

Dynamics 365 Business Central Connector.

For a detailed description of how to create new tasks, refer to the product help.

A NOTE ABOUT TASK DESIGN:When designing theMicrosoft Dynamics 365 Business Central Connector task

step, be aware that each task run only maintains the connection to the Agent for one hour or until the task

completes, whichever happens first. Should the number of records being processed during a single task run

force the connection to remain open for longer than an hour, the task fails with a timeout error. In such

scenarios, consider "chunking" your task processes, see How to Design a "Chunked" Task to Process a Large

Amount of Records Over Multiple Task Runs.

About the General Tab

Use the General tab to choose the BPA Platform data source to be mapped to the Dynamics 365 Business Central

objects. The data source must be in XML form. To map BPA Platform recordsets, configure a Convert Recordset to

XML or TransformData step in the task before theMicrosoft Dynamics 365 Business Central Connector step, then

select this as Task step (see below).

Provide a meaningful Name andDescription for this step.

17 of 38

https://www.codelessplatforms.com/help/bpa/guides/content/tasks/chunked-task.htm
https://www.codelessplatforms.com/help/bpa/guides/content/tasks/chunked-task.htm


TIP: If this task instance makes use of two or moreMicrosoft Dynamics 365 Business Central Connector steps,

ensure the Name used is unique for each individual step.

Data source can either be:

 No data source— If you don’t make use of a dedicated XML input source, select this option to use BPA

Platform variables in place of the XML or recordset objects’ fields.

For example, you can extract various bits of information from an email and store them in BPA Platform

variables. The variables are mapped to Dynamics 365 Business Central operational objects and fields to store

in the database for later use.

 Task step— The data source can be set to an available BPA Platform XML data source.

Only those steps that are capable of natively exposing an XML document at runtime are listed. This may be

anotherMicrosoft Dynamics 365 Business Central Connector step, or a tool such as Convert Recordset to

XML or TransformData.

 Custom schema— An XML schema defines the structure of the parsed XML: what tags are present, and the

nesting of the tags. YouDefine the schema of the XML that is used as the input data source for this step. The

Microsoft Dynamics 365 Business Central Connector tool uses the industry standard XSD format. Any XML

processed by this stepmust conform to this schema else an error will be reported.

If the XSD schema is available, either import it into the Custom Schema Configuration (use the Import

XSD/XML File button), or copy and paste it into the configuration box.

If the XSD schema is not available, you can import an example of the runtime XML (Import XSD/XML File), or

copy and paste it into the configuration box. Use the Parse button to create the schema.

 Input source variable— As well as defining the schema, specify the BPA Platform variable that

contains the XML data at runtime.
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About the Connection Tab

Youmust specify the Dynamics 365 Business Central connection (see Global Configuration) this task stepmust use.

All connections created in the global configuration window are presented here.

Alternatively, you can use a BPA Platform variable or formula to create a dynamic connection, where the connection

used is determined by runtime circumstances. At runtime, the contents of the variable must match the name of one

of the global connections — this is case-sensitive. To do this, youmust install a Microsoft Dynamics 365 Business

Central Agent for each individual company database you want to monitor (even though access is through the same

API). All Agentsmust be registered with the BPA Platform server and a separate global connection created for each

Agent.
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About the Mapping Tab

Use theMapping tab to define links between the data source XML (see About the General Tab) and those required by

Dynamics 365 Business Central. This defines how, at runtime, the incoming XML is to be translated into the XML

required for the relevant object and operation.

The Object drop-down shows the Dynamics 365 Business Central objects. The Operations drop-down shows the

operations available for the selectedObject

Further down, the left-hand XML tree structure shows those data source fields available for mapping . The right-hand

XML tree structure displays those input fields for the selectedObject andOperation.

TIP: If you have selectedNo data source in the General tab, youmust add BPA Platform formulas and variables

to the left-hand data source XML tree structure before mapping.

CreatingMappings

Create links by dragging and dropping a data source field (left) onto its corresponding Microsoft Dynamics 365

Business Central Connector input field (right). Only linked fields are used in the output XML.

BPA Platform formulas and variables can be included in the source data even when using a Task step or Custom

schema— drag them from the BPA Platform Browser to the data source’s XML; these can then be linked to the

relevant input fields. BPA Platform recordsets must first be converted to XML using either the Convert Recordset to

XML or TransformData tool before they can be used here.
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Each operation has an additional field, SupplementaryReference, which allows for traceability when transferring

data from one place to another. Whenmapped, the data resides locally at runtime. It is added to the output, and

creates a record for reference purposes only — you can choose to map any field to SupplementaryReference to

assist with checking where the data originated from or at what time the data transfer occurred, for example.

TheMicrosoft Dynamics 365 Business Central Connector tool uses eXtensible Stylesheet Language

Transformations (XSLT) to translate the received XML. The Advanced Translations (XSLT) tab shows the XSLT

generated for the links created for the object and operation. Use Enable Free Type Mode to directly edit the XSLT —

this is particularly useful when translating a non-standard requirement.

Refreshing theDynamics 365 Business Central Schema

If new fields, objects, and operations have been added to your Dynamics 365 Business Central instance after this

task step was originally created, use Schema Refresh to make the latest API metadata available for use.

Using Filters with Objects

When using SEARCH operations, you canmake use of filters to limit the data involved. At runtime, these fields are

treated as “where clauses”. Available filter conditions are:

Filter Description

= Equal to

<> Not equal to

< Less than

> Greater than

<= Less than or equal to

>= More than or equal to

STARTSWITH Starts with

ENDSWITH Ends with

CONTAINS

The presence of multiple filter fields implies that all conditions must be met.

21 of 38



Nominated fields must be mapped to be included in the output XML. You add filter conditions by right-clicking the

output XML field, and selecting Set as Filter. By default, all filters are set to “equal to”. To change the filter condition,

right-click the field again, and select Set Filter Condition. Change the filter condition as required.

Supported Objects

The following objects and operations are supported in this release of theMicrosoft Dynamics 365 Business Central

Connector:

TIP:Where the object has a corresponding operation, the mandatory fields that must be mapped (see About the

Mapping Tab) are shown in bold underneath.

Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Account 

ID


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Aged

Accounts

Payable



VendorID


No

mandatory

fields for

the

SEARCH

operation.

Aged

Accounts

Receivable



CustomerID


No

mandatory

fields for

the

SEARCH

operation.

Attachment

s



ID
ParentID



No mandatory

fields for the

ADD operation;

the keys are

auto-generated

if not mapped.



ID
ParentID



ID
ParentID



No

mandatory

fields for

the

SEARCH

operation.

Balance

Sheet



LineNumber


No

mandatory

fields for

the

SEARCH

operation.

Bank

Account



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Cash Flow

Statement



LineNumber


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Company

Information



ID


ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



No

mandatory

fields for

the

SEARCH

operation.

Country

Region



ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Currency 

ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Customer

Financial

Detail



ID


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Customer

Payment

Journal



ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Customer

Payment



ID

Although this

operation is

available, you

cannot add a

Customer

Payment

record in

isolation. It

must be done

as part of the

new Customer

Payment

Journal record

or as an update

to Customer

Payment

Journal.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Customer

Sale



CustomerID
CustomerNumb

er
Name



No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Customer 

ID


DisplayNam

e



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.

Default

Dimensions



DimensionID
ParentID



No mandatory

fields for the

ADD operation;

the keys are

auto-generated

if not mapped.



DimensionID
ParentID



DimensionID
ParentID



No

mandatory

fields for

the

SEARCH

operation.

Dimension

Line



ID
ParentID



No mandatory

fields for the

ADD operation;

the keys are

auto-generated

if not mapped.



ID
ParentID



ID
ParentID



No

mandatory

fields for

the

SEARCH

operation.

Dimension

Value



ID


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Dimension 

ID


No

mandatory

fields for

the

SEARCH

operation.

Employee 

ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.

General

Ledger

Entry



ID


No

mandatory

fields for

the

SEARCH

operation.

General

Ledger

Entry

Attachment

s



GeneralLedger

EntryNumber
ID



No mandatory

fields for the

ADD operation;

the keys are

auto-generated

if not mapped.



GeneralLedg

er

EntryNumber
ID



GeneralLedg

er

EntryNumber
ID



No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Income

Statement



LineNumber


No

mandatory

fields for

the

SEARCH

operation.

Item

Category



ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Item 

ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Journal

Line



ID

Although this

operation is

available, you

cannot add a

Journal Line

record in

isolation. It

must be done

as part of the

new Journal

record or as an

update to

Journal.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Journal 

ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

POST— ID
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Payment

Method



ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Payment

Term



ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Pdf

Document



ID


No

mandatory

fields for

the

SEARCH

operation.

Picture 

ID


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Project 

ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Purchase

Invoice

Line



ID

Although this

operation is

available, you

cannot add a

Purchase

Invoice Line

record in

isolation. It

must be done

as part of the

new Purchase

Invoice record

or as an update

to Purchase

Invoice.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Purchase

Invoice



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.

POST— ID

Retained

Earning

Statement



LineNumber


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Sales

Credit

Memo

Line



ID

Although this

operation is

available, you

cannot add a

Sales Credit

Memo Line

record in

isolation. It

must be done

as part of the

new Sales

Credit Memo

record or as an

update to Sales

Credit Memo.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Sales

Credit

Memo



ID
NOTE: The child

object Pdf

Document is not

returned unless a

POST operation has

been performed for

the Sales Credit

Memo record which

includes the Pdf

Document.



No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.

CANCEL AND SE

ND— ID
CANCEL— ID
POST AND SEND

— ID
POST— ID
SEND— ID
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Sales

Invoice

Line



ID

Although this

operation is

available, you

cannot add a

Sale Invoice

Lines record in

isolation. It

must be done

as part of the

new Sales

Invoice record

or as an update

to Sales

Invoice.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Sales

Invoice



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped if not

mapped.



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.

CANCEL AND SE

ND— ID
CANCEL— ID
POST AND SEND

— ID
POST— ID
SEND— ID
MAKE

CORRECTIVE

CREDIT MEMO—

ID

Sales

Order

Line



ID

Although this

operation is

available, you

cannot add a

Sales Order

Line record in

isolation. It

must be done

as part of the

new Sales

Order record

or as an update

to Sales Order.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Sales

Order



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.

SHIP AND

INVOICE— ID

Sales

Quote

Line



ID

Although this

operation is

available, you

cannot add a

Sales Quote

Line record in

isolation. It

must be done

as part of the

new Sales

Quote record

or as an update

to Sales

Quote.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Sales

Quote



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.

MAKE INVOICE

— ID
SEND— ID
MAKE ORDER—

ID

Shipment

Method



ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Tax

Area



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Tax

Group



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.
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Object

Operations

READ ADD UPDATE DELETE SEARCH
Additional

Supported

Time

Registration

Entry



ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Trial

Balance



Number


No

mandatory

fields for

the

SEARCH

operation.

Unit of

Measure



ID


Code


ID


ID


No

mandatory

fields for

the

SEARCH

operation.

Vendor

Purchase



Name
VendorID
VendorNumber



No

mandatory

fields for

the

SEARCH

operation.

Vendor 

ID


No mandatory

fields for the

ADD operation;

the key is auto-

generated if not

mapped.



ID
NOTE: If

updating the

address for a

record, you must

send through all

lines of the

address not just

the affected line.

Sending a partial

address may

cause the

address to be

deleted, leaving

only the updated

lines.



ID


No

mandatory

fields for

the

SEARCH

operation.
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NOTE: If your Dynamics 365 Business Central installation makes use of web services the codeunits, pages, and

queries are also displayed in the Objects drop-down in theMapping tab— they have (Service) after the object

name, for example, Sales Documents (Service). As such objects are installation-specific, they are not listed in

this document.

Their operations are as follows:

 Pages — READ, ADD, UPDATE, DELETE, SEARCH

 Queries — READ, SEARCH

 Codeunits — The function used by the codeunit is displayed as the operation, for example, for a workflow

codeunit youmight have APPROVE and REJECT

For more information about using codeunits in Dynamics 365 Business Central, refer to your Microsoft

documentation.

A Note About Updating Child Objects From Parent Objects

If performing an UPDATE on an object that has child objects where you are updating parent-level and child-level fields,

how youmap the child-level fields determines whether a new child record is added or an existing child record

updated:

 If a child object has all [Key] fields mapped, this is treated as an UPDATE operation— The mapped keys are

used to find the relevant record.

 If a child-level [Key] field is not mapped but a child-level field is, this is treated as an ADD operation— A new

child record is added with the relevant keys auto-generated.

For example, this mapping adds a new Picture child record against the mapped Employee ID.

 If a child object has more than one [Key] field but only one is mapped, again this is treated as an ADD

operation— A new child record is added with the unmapped keys auto-generated.

For example, the child object, DefaultDimensions, has two [Key] fields but only one is mapped. For this

scenario, a new DefaultDimensions record is added with the ParentID being auto-generated.

 Some objects have more than one child objects. Those child objects that are not involved in the mapping are

not affected by the UPDATE operation at task runtime.

For example, the Employee object has three child objects: Picture, DefaultDimensions, and

TimeRegistrationEntries. This mapping does not affect any existing child records for DefaultDimensions or

TimeRegistrationEntries.
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The following table indicates those objects with child-level objects and their [Key] fields:

Object Child Object [Key] Field

Customer Payment Journal CustomerPayments ID

Customer CustomerFinancialDetails ID

Picture ID

DefaultDimensions ParentID

DimensionID

Employee Picture ID

DefaultDimensions ParentID

DimensionID

TimeRegistrationEntries ID

Item Picture ID

DefaultDimensions ParentID

DimensionID

Journal Line Attachments ParentID

ID

Journal JournalLines ID

Attachments

(as child of JournalLines, therefore grandchild)

ParentID

ID

PurchaseInvoice PurchaseInvoiceLines ID

PdfDocument ID

Sales Credit Memo SalesCreditMemoLines ID

PdfDocument ID

Sales Invoice SalesInvoiceLines ID

PdfDocument ID

Sales Order SalesOrderLines ID

Sales Quote SalesQuoteLines ID

PdfDocument ID

Vendor Picture ID

DefaultDimensions ParentID

DimensionID
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About the Options Tab

The Options tab allows you to define how errors in this step are handled at task runtime.

If an error occurs, you can decide whether the step should Continue processing, or terminate the step immediately

(Abort Step).

If the step is aborted, you can choose to Continue processing onto the next step in the task, or terminate the

whole task immediately (Abort Task). By allowing the task to Continue, you can use the error XML received back in a

Save File step for investigation purposes, for example.
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performance, boosting efficiency and cutting costs.

+44 (0) 330 99 88 700

enquiries@codelessplatforms.com

www.codelessplatforms.com


	Introduction
	The Microsoft Dynamics 365 Business Central Connector Tool Pack
	System Requirements
	Minimum BPA Platform Version
	Minimum Dynamics 365 Business Central Version


	Architecture
	Cloud Architecture
	On-Premise Architecture

	Working with Other Tools
	Consuming from Other Tools
	Objects Consumed

	Exposing to Other Tools
	Objects Exposed

	Where Can the XML Output be Used?
	Error Handling


	Global Configuration
	Using Extended Logging
	About the General Node
	Updating Objects and Operations

	About the Agent Connection Node
	About the General Node
	About the Advanced Node

	About the Business Central Connection Node
	About the Deployment Type Node
	About the Cloud Connection Node
	About the On-Premise Connection Node

	About the Select Company Node

	Step Configuration
	About the General Tab
	About the Connection Tab
	About the Mapping Tab
	Creating Mappings
	Refreshing the Dynamics 365 Business Central Schema
	Using Filters with Objects
	Supported Objects

	About the Options Tab




